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Introducing Corel PaintShop Pro X8

The world has become strikingly visual, at work and at home. Almost every time we use our devices, we
see interfaces and a wide variety of designs—visual expressions made possible by creative software.

This is the world of PaintShop Pro. Whether it's editing photos, designing web graphics, or making
scrapbook pages and other projects, PaintShop Pro represents something unique — software that's
inviting and affordable, yet delivers power, speed, and creative capabilities that rival the 800-pound
gorilla of photo editing. We're happiest when we're able to deliver tools to our customers that are
innovative, easy-to-use, and help people be more productive. PaintShop Pro X8's new text wrapping
feature is a good example of an innovative feature inspired by listening and responding to our users.
Wrapping text within a shape or selection is a task that can be frustrating in other photo software, and
our goal was to make it fast and simple, so anyone, regardless of skill level or profession, can get the job
done faster — no monthly fee required.

For your passion or profession, PaintShop Pro is here for you.

Greg Wood
Product Manager, Corel PaintShop Pro
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Here's a glimpse of the people who are driving
PaintShop Pro’s success.

Photographers

First and foremost, PaintShop Pro is designed
from the ground up for the photo enthusiast.
Whether they're just starting out as hobbyists
with their first DSLR, prosumers, or photo
enthusiasts, they need tools that help them
achieve their creative vision. That might be the
quick adjustment of 1000 photos from a
wedding shoot, or it might be detailed
restoration of a unique old photograph.
PaintShop Pro provides the comprehensive ability
to edit, make quick adjustments and manage an
entire photo collection within one product.

Graphic Designers and Creative Consumers

PaintShop Pro's layers, vector tools, and painting
and drawing tools are ideal for many graphic
designers—whether at home or at work.

Graphic designers tend to live in our Edit
workspace and use layers to make a variety of
compositions, including scrapbook content,
posters, web graphics and more. Support for
vector illustration is key here, with use cases
similar to what we see with PhotoShop.

We often emphasize photography with PaintShop
Pro, but design tools are part of PaintShop's
“DNA", from its earliest development. Graphic
designers produce content for many projects and
want tools that help them express their creativity.
Whether they're working photographers, graphic
design professionals, video producers, or web
professionals, they want a photo editor that lets
them work with vector and raster layers, supports
industry-standard file formats, and gives them
powerful creative options.

Creative consumers produce content to share
with friends and family. They want a photo editor
that's easy to use, stays out of their way, and
gives them access to a wide range of features and
effects.
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Business and Education

Whether in a small business or a large enterprise,
PaintShop Pro is enormously valuable at work.The
photo editing capabilities, design tools, and
ability to open a wide variety of image formats,
make it a versatile application that is likely to
generate an immediate return on its moderate
price.

Small business owners, independent or
professional marketers, and social media
specialists want a photo editor that fits their
budget and lets them quickly produce high-
quality graphics in-house.

Whether cleaning up images in engineering firms,
creating graphics for social media, or enabling
students to create a wide variety of creative
content, we know that the volume licensing and
network deployability has made PaintShop Pro an
excellent choice for business and education
settings.



What's included?

* Corel® PaintShop® Pro X8: This powerful,
versatile image-editing software helps anyone
produce stunning photos and designs. It
offers a wealth of features that help you
organize, edit, and share your photos and
artistic creations.

* 32- and 64-bit versions: PaintShop Pro X8 is
available in 32- and 64-bit versions.

* Online Help, Learning Center palette
* PDF User Guide

* In-product link directly to video and text
tutorials in the Discovery Center

* Getting Started windows provide an overview
of some tools and features

* PDF Scripting Guide, available for download

*  Windows® 10, Windows 8/8.1, Windows 7
with latest service packs installed (32-bit or
64-bit editions)

* Intel® or AMD 1.5 GHz or faster processor
with SSE2 support (multi-core processor
recommended)

e 2 GB of RAM (4 GB recommended)

* 1 GB of free hard disk space (2 GB
recommended)

* 1024 x 768 resolution, 16-bit color display
(1366 x 768 resolution, 24-bit or higher color
display recommended)

* DirectX® 9 or higher compatible video
adapter with latest driver

* Internet connection required for accessing
online features and video tutorials

Windows-compatible CD- or DVD-ROM drive
for installation

Input: Al, BMP, CAL, CALS, CGM, CLP, CMX,
CT, CUR, CUT, DCX, DIB, DRW*, EMF, EPS, GIF,
HDP, HGL*, HPG*, IFF, IMG, J2C, J2K, JIF, JP2,
JPC, JPE, JPEG, JPG, JPS, JPX, MAC, MPO,
MRW, MSP, PBM, PCD*, PCT, PCX, PDF, PGL*,
PGM, PIC, PICT, PNG, PNS, PPM, PS, PSD, PSP
(PSP image files), RAS, RAW, RIF, RLE, SCT,
SVG, SVGZ, TGA, TIF, UFO, WBM, WBMP,
WDP, WEBP, WMF, WPG*

RAW file support from more than 300 camera
models including 3FR, ARW, CR2, CRW, DCR,
DNG, K25, KDC, NEF, NRW, ORF, PEF, RAF,
RW2, SR2, SRF, X3F

Output: BMP, CAL, CALS, CLP, CUT, DCX, DIB,
EMF, EPS, Al, PS, GIF, HDP, WDP, IFF, IMG, JP2,
12C, 12K, JPC, JPX, JPG, JIF, JPE, JPEG, MAC,
MSP, PBM, PCX, PGM, PIC, PPM, PNG, PSD,
PSP (PSPIMAGE FILES), RAS, RAW, RIF, RIFF,
RLE, SCT, CT, JPS, PNS, TGA, TIF, TIFF, WBMP,
WBM, WEBP, WMF

Brush: PaintShop Pro Brush (.pspbrush),
Adobe Photoshop Brush (.abr), Jasc Brush
(.jor)

1. CMX, DRW, HGL, HPG, PCD, PGL, and WPG formats
supported only with 32-bit installation
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Corel® PaintShop® Pro X8 is powerful image-
editing software that helps anyone produce
stunning photos and creative designs.

New! Text wrapping: Corel PaintShop Pro X8
makes it easy to use text as a design element in
your creative projects. New Text Wrapping lets
you wrap text inside any vector shape or
selection. Simply choose your shape or draw your
selection using any of the selection tools, and
type your text. The text automatically wraps
within the shape. This is an ideal effect for
posters, scrapbooking, brochures, collages,
websites and other projects.
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You can wrap text in selections (top)
and vector shapes (bottom).

Te amo. Te amo.
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To wrap text within a shape

In the Edit workspace, click a selection tool or
a vector shape tool and in the image window,
drag to create a selection or vector shape.
Click the Text tool and click inside the selection
or vector shape, at the start position for your

3 Type your text.
4 The text automatically wraps to stay within the
shape or selection.

If there is too much text for the space, the extra
text appears outside the shape or selection.

New! Magic Move tool: Accelerate editing
with Magic Move, a new content-aware tool that
automatically replaces the background when you
move an object or person. Simply select an area
and drag it to a new position. The empty area left
behind is automatically filled to match the
surrounding background.

You can move people or objects
with the Magic Move tool.
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Give it a try Give it a try

To move an image area with Magic Move

1 In the Edit workspace, click a selection tool
and in the image window, select the area that
you want to move.

Note: You don’t have to be precise—leaving a
buffer area around the object you select
produces better results.

Tip: On the Tool Options palette, increase the
Feather value to 5-20 to improve edge results.

2 On the Tool Options palette, click
Magic Move <.

3 In the image window, drag the selected area
to a new position.

The remaining empty area is filled with a
content-aware fill that matches the
surrounding background.

You can fine-tune the results with the Clone
Brush or one of the retouch brushes.

To use the Batch Process wizard to add
watermarks

1 Click File » Batch Process.

2 Click Add, choose some photos, and click Next.
3 On the Batch Actions page, click Watermark.
a4

In the Visible Watermark box, browse to the
existing logo or text file that you want to use
as a watermark.

5 In the Visible Watermark box, choose the
settings you want, and click OK.

6 Choose any additional batch actions.

Tip: If you add scripts, consider enabling the
Silent Mode check box to avoid pop-up dialog
interruptions requesting user input.
7 Click Next, and choose the Output Settings
you want.

8 Click Start.
The watermark and any other batch actions are

applied to all the photos.

Enhanced! Batch processing: Save time by
applying common actions to multiple photos
with the new Batch Process wizard. Resize, add
watermarks and picture frames, apply scripts, and
control the file names, formats, security-related
information, and more — the wizard makes it
easy.

You can save time with the Batch Process wizard.
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New & Enhanced! Selection tool options: Fast
and accurate selection tools are a must for any
photo editor. The enhanced Smart Selection
Brush now includes a Tolerance setting for more
precise selections across areas that are close in
tone or hue. New Selection Style options for the
Selection Tool let you define a selection size by
typing height and width values, or you can define
a fixed aspect ratio for the selection. You can also
choose from a list of popular aspect ratios and
resolutions.

With PaintShop Pro X8, you can
create more precise selections.

Enhanced! Power and speed: The new
Corel PaintShop Pro includes performance gains



that save you time and make editing tasks more
responsive and enjoyable:

* Faster brushes for a more responsive feel —
Enjoy speed gains of 40%—120% for brushes,
including Paint Brush, Air Brush, retouch
brushes (Dodge, Burn, Soften and others),
and art media brushes (Oil Brush, Chalk,
Marker and others)

* Larger maximum brush size — Cover more
area, more quickly with an increased
maximum brush size of 3,000 pixels

* Enhanced Smart Edge — See up to 50%
faster performance when using the Smart
Edge feature, which works with several tools
help keep your brushstrokes “inside the lines”

» Faster saving — our native PaintShop Pro
image file format (*.pspimage) saves up to
50% faster, to keep you in your creative
groove

New! High resolution 4K monitor support:

Pair PaintShop Pro X8 with a high resolution
monitor for the best-looking PaintShop Pro ever.
See each detail, read more clearly and easily, and
appreciate every aspect of your photo or
composition in a beautifully rendered high
resolution interface. All-new icons and enhanced
workspaces are compatible with Ultra High DPI
displays (up to 250% zoom with 4K resolution).

/“\
/' Corel PaintShoy

File Edit View Image .,
RSERE <

PaintShop Pro X8 has been optimized for
higher resolution monitors.

New & Enhanced! Layer workflow: Layers are
fundamental to advanced photo editing,
compositing and graphic design. The following
features make it easier to work with multi-layer
projects:

* Quick Search — find the right layer in
seconds when you search for it by name. This
is especially useful for projects with many
layers

* Merge layers — merge selected layers or
create a new layer from selected or visible
layers

* Expand or collapse all layer groups — easily
expand and view all layers in your project

PaintShop Pro X8 offers more options for
multi-layer projects.

New! Lens Correction: You can correct the
distortions, vignetting and chromatic aberrations
that are commonly introduced by most camera
lenses. Whether you're in the Edit workspace or
the Camera RAW Lab, you can apply Lens
Correction tools automatically, taking advantage
of the wide range of lens profiles included in
Corel PaintShop Pro, or take full control and apply
corrections manually.
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You can correct problems introduced by
camera lenses.
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Enhanced! Camera RAW Lab: Inspired by easier. You can also add more photos without

insights from Corel PaintShop Pro users, the having to close the RAW Lab, and apply lens
Camera RAW Lab offers an enhanced layout, corrections. As always, we continue to add
including before and after views, and a bigger support for latest camera models.

preview to make working with RAW images

] Camera RAW Lab - o lEH

Camera RAW Lab in PaintShop Pro X7 (top) and PaintShop Pro X8 (bottom)

New! Enhancements suggested by our users: * New Save behavior and Save As dialog box
— see and adjust compression settings to

We love getting suggestions from ensure that your image looks right

Corel PaintShop Pro users. As part of our ongoing

commitment to empower creativity, we have * Swatches in the Material Properties window
included the following improvements, suggested — access all the swatches you have created
by our users: more easily

* Cutter Preview for Shape Cutter and Text
Cutter — a semi-transparent overlay lets you
preview the area you are cutting before you
apply your cutout

* Before/After button in the Adjust workspace
— quickly see what you have changed versus
the original with a simple click
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* Gradient Preview -— now you can view
gradient updates on your image as you make
the changes in the Material Properties
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Here's a snapshot of features that are frequently workspaces that present tools and options for

cited by users as the reason they chose PaintShop each intended task. The refined workspaces

Pro. reduce clutter and duplication, which makes
PaintShop Pro more welcoming and easier to use.

Three apps in one: With PaintShop Pro, you'll

find dedicated Manage, Adjust, and Edit

L8 8 8 8

PaintShop Pro X8 provides dedicated workspaces that let you focus on the task at hand.
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Give it a try

Taking a workspace tour

1 In the Manage workspace, click the Preview
Mode =% button.

This switches the workspace from Thumbnail
Mode to Preview Mode. To switch back, click

the Thumbnail Mode ... button.

The Manage workspace has four main
components:

* Navigation palette — for finding and
organizing your photos

* Preview area — for viewing a single image
or thumbnails of all images in the active folder
* Info palette — for viewing and entering
EXIF or IPTC data

* Organizer palette — for selecting photos

2 At the top of the workspace, click the Adjust
tab.

The Adjust workspace has four main
components:

* Adjust palette — tools and controls for
adjusting photos

* Preview area — displays the photo selected
in the Organizer palette

* Instant Effects palette — preset effects

* Organizer palette — for selecting photos

3 At the top of the workspace, click the Edit tab.

The Edit workspace has five main components:

* Tools toolbar — tools for painting,
drawing, cropping, typing text, and
performing other image editing tasks

* Tool Options palette — settings and
controls for the active tool

* Layers palette — view, organize, and
adjust image layers

* Materials palette — colors and materials
for painting, drawing, filling, and retouching
* Image window — displays open files

Smart Selection Brush: This brush uses a photo
segmentation engine that lets you select objects
based on brushstrokes. Photo segmentation
collects pixels into regions that correspond to
separate surfaces, objects, or natural edges of an
object. This means that you can simply paint over
an object to select it, and you can build or reduce
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the selection with additional brushstrokes. It's a
fast, easy, and accurate way to isolate part of an
image.

You simply drag the Smart Selection
Brush over an image area to create and
refine a selection.

Give it a try

Using the Smart Selection Brush

1 In the Edit workspace, open a photo that
contains an object or person that you want to
isolate.

2 On the Tools toolbar, click the Smart
Selection Brush
3 On the Tool Options palette, adjust the Size
setting.
You can also adjust any of the following
settings:

* Mode — specifies whether to replace,
add, or remove an existing selection

* Feather — softens the edges of a
selection by specifying a fade width

* Anti-alias — smoothens the edges of a
selection by using transparency

4 Drag the brush across the image area that you
want to select, and release to review the
selection.

You don't need to be precise; the selection
expands automatically to toward edges.

You can press Shift and drag to add to the
selection, or press Ctrl and drag to remove the
selection.




Auto Selection tool: This tool lets you enclose an
image area in a bounding rectangle that
automatically detects and snaps to edge. It's
quick and simple, and does most of the work for
you, which lets you focus on being creative.

The Auto Selection tool automatically
detects and snaps to the edges of an
object area that you select.

Give it a try

Using the Auto Selection tool

1 In the Edit workspace, open a photo that
contains an object or person that you want to
select.

2 On the Tools toolbar, click the Auto Selection
£ tool.

3 Drag across the image to enclose the area that
you want to select, and release to view the
auto-selection.

To redo the selection, press Ctrl + D and then
reselect an area.

Magic Fill: Magic Fill is a content-aware feature
that can make unwanted elements of your
photos vanish. Use your favorite selection tools to
select an area or object that you want to remove
and apply Magic Fill to replace the selection with
a background that matches the surrounding area
— even when the surrounding area is textured or
varied.

You can make parts of a photo disappear
with Magic Fill.

Shape Cutter and Text Cutter: You can use vector
shapes, such as Preset Shapes, to create cutouts
that are filled with the background imagery. The
effect is similar to using a clipping mask, except
the cutout object is created as a new file with a
transparent background—perfect for collage,
scrapbook, or other creative photo projects.

Shape Cutter

FARPE M

Text Cutter
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HDR processing: PaintShop Pro lets you explore
HDR (High Dynamic Range) processing—a
method that combines multiple photos of the
same scene, shot at different exposures. HDR lets
you access a broader tonal range to create a final
image that can be breathtaking. PaintShop Pro
includes Exposure Merge, for a full processing
control, Batch Merge, for processing multiple
HDR sets at one time, and an HDR effect, Single
RAW Photo, that simulates an HDR effect using
only one RAW photo.

Exposure Merge uses a three-step process:

* Merge — choose merge settings, apply
custom editing to photos

* HDR Adjustments — make adjustments to
merged HDR image

* Fine-Tune — refine the HDR image, reduce
noise, sharpen, etc.

You choose merge settings, make
custom edits, and preview the merged
alignment during the first step of
Exposure Merge.
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Give it a try

Step 1: Merging multiple HDR exposures

1 Inthe Manage workspace, press Ctrl and then
click to select the thumbnails of the photos
you want to merge.

2 Click File » HDR » Exposure Merge.

3 Inthe Step 1: Merge window, choose a profile
from the Camera response curve profile
drop-list.

If you are unsure, select Auto Select.

4 In the Alignment area, choose an alignment
type from the Method drop-list.

To crop edges that don’t overlap, enable the
Auto crop check box.

5 Click Align.

To see the result, enable the Preview
Alignment check box near the bottom of the
panel.

6 If necessary, you can keep or remove specific
areas from individual photos by using the
controls in the Custom editing area.

7 Click Process.

You can manually adjust the resultant
HDR image or apply a preset during
the second step of Exposure Merge.



Give it a try

Step 2: Adjusting the HDR image

1 In the Step 2: HDR Adjustments window,
perform any of the following actions to
achieve the look you want:

* in the Presets area, click a preset thumbnail

* enable the White Balance check box, click
the Dropper tool, and then click the image to
set the white point

* drag the Temperature slider to warm or
cool the image, and drag the Tint slider to

fine-tune the color You can apply photo fixes, color and

« drag the Contrast, Highlights, Midtones contrast corrections, remove noise, and
and Shadows slider to adjust the tone and more during the final step of Exposure

contrast Merge.

* drag the Vibrancy slider to saturate or
desaturate the colors

* choose Creative detail or Natural detail Give it a try

from the Dgtail drop-I!st, and then drag the Step 3: Fine-tuning the HDR image
respective sliders to adjust the amount of local =1ep 2 Hne-tuning the HUR Image

detail 1 In the Step 3: Fine-Tune window, apply any of

) . ) the following tools or adjustment options:
To focus on black-and-white processing, click 9 J P

the B&W tab. * Smart Photo Fix
To re-enable color processing, click the Color * White Balance
tab. * Brightness/Contrast
e o e e « Fil gl
then click Save. * Local Tone Mapping
3 Click Process. * High Pass Sharpen
The settings are applied to the 16-bit image file * Digital Noise Removal

in preparation for final output.

When you are satisfied, click Save and close.

In the Save As dialog box, type a file name,
and then click Save.
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Scripting: In combination with batch editing and
custom presets, scripting can help you accelerate
common or repetitive tasks. PaintShop Pro X8
provides an updated script framework to help you
take advantage the application’s automation
capabilities. You can record a series of commands
as a script that you can playback at any time. This
can save you significant time with tedious tasks,
which is especially useful if you apply the same
effect(s) to many photos.

You can use scripting to automate
applying a Dragan effect to a photo or
series of photos.
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